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1. Re-arrange the following steps which show the stages of loading the 

Operating System: 

1) Make a copy of the operating system and put it in "RAM" ( ) 

2) Check the computer hardware and its validity.   ( ) 

3) Press "Power" button.       ( ) 

4) The Operating System loads and the "Desktop" appear. ( ) 

2. Correct the underlined in the following sentences: 

1) The Traditional Computer works on the battery.  (……………….…………..) 

2) To turn the computer on, press the Monitor button. ( ……………….…………..) 

3) To turn the computer off safely select Restart from the window that will appear.

          (……………….…………..) 

4) To open start menu, Right click on start.   (……………….…………..) 

5) We can turn the computer off safely by pressing Ctrl +F4 buttons in the 

keyboard.         (……………….…………..) 

3. Complete the following sentences from the brackets: 

(Graphical Operating Environment – battery – Power button – Start – Case) 

1) Laptop works by ……………….………….. which needs to be charged from one 

time to another. 

2) "Turn off computer" is in ……………….………….. Menu. 

3) From the advantages of "Windows" Operating System is ………………………………………... 

4) The "Power" button is in ……………….…………... 

5) ……………….………….. Has no fixed location in the computer, but it differs from     

a device to another. 
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4. Choose: 

1) To open the Computer, you should press the (Monitor – System Unit) button. 

2) To open the Monitor you should press (Monitor – System Unit) button. 

3) “Turn Off Computer” is in the (Power button – Start) menu. 

4) To operate the computer, you should make sure of (The set is plugged – 

The Operating System is available  – both)  

5) To turn off the computer select (Restart – Turn Off) from the dialogue box. 

5. Put (√) or (×): 

1) The shape and location of the "Power" button doesn't differ from a computer to 

another.   (      )   

2) The computer can be turned off safely by pressing the "Power" button. ( ) 

3) Laptop works by the battery.   (    ) 

4) There is no difference between the computer before and after operation. (  ) 

5) There is only one way for turning the computer off safely. (  ) 

6. Complete the following sentences from the brackets: 

(Taskbar – Icons – File – My Documents – OK – Recycle Bin) 

1) The objects which are on the desktop, are named ……………….…………... 

2) The deleted files go to ……………….…………... 

3) The date and time appear on ……………….…………... 

4) ……………….………….. Is used for saving the important file and accessing them easily. 

5) The button ……………….………….. is used for executing the orders. 
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7. Put (√) or (×): 

1) There is only one method for opening any icons on the desktop. (  ) 

2) "Paint" icon is of the main icons.   (  ) 

3) The icons with the same types can be arranged beside each other's by 

"Type".        ( ) 

4) The importance of the desktop icons is due to the fastness and easiness 

in using them.       (  ) 

5) The desktop icons can't be re-arranged again. (  ) 

8. Complete the following diagram : 

  

    

 

 

 
 

 

 

9. Match: 

1) Saves documents      (    ) My Computer 

2) Deals with hardware and software   (    ) My Documents 

3) Displays Internet site     (    ) Recycle Bin 

4) Includes deleted files     (    ) My Network Places 

5) Controls the computers in a network  (    ) Internet Explorer 

1.……………………

…. 

3.……………………

…. 

2.……………………..……. 
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10. Complete the following sentences from the brackets: 

(My Documents – Manual – Shortcut – Auto Arrange – Double click – 

Right click) 

1) When right clicking on a free space on the desktop the ……………….…………..menu 

appears. 

2) We can open any of the desktop icons by ……………….…………..or ……………….…………... 

3) To make the icons arrangement unchangeable, select 

……………….…………..from "Arrange Icons by". 

4) ……………….…………..Is of the desktop main icons. 

5) To arrange the icons as a triangle, we use ……………….…………..method. 

11. Re-arrange the following steps to change the Screen Saver: 

( ) Press on Screen Saver tab and select your Screen Saver 

  ( ) Select Properties from the Shortcut Menu 

 ( ) Select OK  

   ( ) Press Right Click on the free space of the Desktop 

12. Put (√) or (×): 

1) The number of the icons on the desktop differs from a computer to another. (    ) 

2) "My Computer" window is the first to appear after loading the Operating 

System.           ( ) 

3) The image on the desktop can't be changed.   ( ) 

4) From the functions of the desktop is organizing the work and reaching 

what we want easily.        ( ) 

5) The deleted files can't be restored after being moved to the Recycle Bin. (      ) 

6) There is no difference between the window icons and the icons we 

create.           ( ) 
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13. Give the suitable term for the following sentences from the brackets: 

(Taskbar – Desktop – My Computer – Icons – Screen Saver) 

1) Helps in performing the tasks quickly and by which we can know date and 

time.   (……………….…………..) 

2) The first thing to appear after loading the Operating System window. 

( ……………….…………..) 

3) One of the desktop icons by which we can deal with the computer 

hardware.  (……………….…………..) 

4) Protects the screen when we stop working on it temporarily.             

( ……………….…………..) 

5) From the components of the desktop and it has a type (main and 

secondary). (……………….…………..) 

14. Match: 

(A) (B) 

1 Name A Arranges by date from the older to the most recent. 

2 Size B Arranges icons alphabetically. 

3 Type C Arranges according to the icons size in the memory. 

4 Modified D 
Make the icons of the same types beside each 

other's. 

 

 

15. Arrange the following steps which express the arrangement of the icons 

in unchangeable way: 

1. Select "Arrange Icons by" from the shortcut menu.   ( ) 

2. Right click on a free space on the desktop.     ( ) 

3. Select "Auto Arrange" which stops moving the icons manually.  ( ) 

 

(1,……..) (2, ……..) (3, ……..) (4, ……..) 
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16. Complete the following sentences: 

1) The icons of the desktop can be arranged ……………….…………..Or ……………….…………... 

2) To arrange the icons according to the date of their modification select 

……………….…………... 

3) To open "My Computer" icon press ……………….…………... 

4) ……………….…………..arrange the icons that can't be arrange manually. 

17. Re-arrange the steps for changing the "Start  Menu into Classic Start 

Menu": 

( ) Select "Start "tab menu from Properties window 

( ) Click "OK" 

( ) Select "Properties" from the Shortcut Menu 

( ) Right Click on the free space on the Taskbar 

( ) Select "Classic Start Menu" 

18. Complete the following sentences from the brackets: 

(Display the active programs in the memory – Group similar taskbar 

buttons – Tab – Antivirus – Close) 

1) When the icon  √ beside the ……………….…………..Property is chosen, the 

similar windows are grouped in one button on the taskbar. 

2) We can alternate within the open windows by pressing Alt + ……………….….in 

the keyboard. 

3) ……………….…………………………..………..is of the function of Taskbar. 

4) ……………….…………..Is of the programs in the memory. 

5) The window can be closed from the Taskbar by choosing 

……………….…………... 
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19. Put (√) or (×): 

1) The windows button disappears from the taskbar upon closing the window. (       ) 

2) We can open the "Calculator" program from the "Start" menu.  (  ) 

3) "Lock the Taskbar" property doesn't allow you to move the taskbar. (  ) 

4) It isn't possible to close the similar programs in one button at one time. (  ) 

5) The deleted files can be restored by the Taskbar.    (  ) 

20. Put (√) or (×): 

1) The shape of the button of the window when the window is open is different from 

its shape when it is minimized.         ( ) 

2) It isn't possible to minimize or maximize the window by the use of the keyboard. (  )  

3) The Operating System windows are standard windows with one base.  (  ) 

4) The window icon appears in the title bar on the right beside the control button. (  )  

5) The name of the window appears on the toolbar.     ( ) 

6) We can close the window by pressing Alt+F4 in the keyboard.   ( ) 

21. Complete the following sentences from the brackets: 

(Title – F4 – Restore Down – Maximize – Restore Down – Task) 

1) To close the window from the keyboard, press Alt + ……………….…………... 

2) The Control Button appears in the ……………….…………..Bar. 

3) The Program Icon appears in the ……………….…………..Bar. 

4) We can Restore the window size which covers the screen completely by ……………... 

5) The button ……………….…………..and ……………….………….. have the same 

location in the Control Button. 
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22. Complete the following sentences from between brackets: 

(Control Panel – Creating files – Battery –Double click – Date and Time – Start) 

1) The importance of setting the date and time in windows is to know the date 

and time of ……………….…………... 

2) You can open the "Date and Time properties" by opening the 

……………….…………..menu, then select ……………….…………... 

3) The computer save the current time and date by a memory which works 

with ……………….…………... 

4) You can open the date and time window by ……………….…………..on the clock icon 

on the taskbar.  

5) To set the hour, minute and second click ……………….…………..tab above the window. 

23. Put (√) or (X):  

1) The importance of the Date and Time setting is to know the date and time of 

creating files.          ( )  

2) (GMT + 02:00) means that the time at this place is two hours more than Cairo 

timing.           ( ) 

3) The "Date and Time" properties are opened by right click on the clock on the 

Taskbar.            ( )  

4) You can know the current date and time from the "Control Panel".  ( )  

5) You can set the day date from "Time Zone".      ( ) 

6) The calculation of the date and time stops as long as the computer is 

shutdown.           ( ) 
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24. Complete the following sentences from between brackets:  

(Control Panel – Date – Country – Time – Date and Time)  

1) To control the date format, open ……………….…………..Tab.  

2) To modify the time, select ……………….…………..Icon from the control widow.  

3) When pointing by the mouse pointer to the clock on the taskbar, 

……………….…………..appears. 

4)  To change all the measures and types of numbers, currency, date and time, 

change ……………….…………...  

5) The regional options can be accessed from ……………….…………..Window. 

25. Put (√) or (X):  

1) The forms of date, time, numbers and currencies are not influenced by changing 

the country or area.        ( ) 

2) To get "Regional Option" window, double click on the clock on the Taskbar. (   ) 

3) To change the date, time, number and currency settings, you should install a new 

version of the windows operating system.    ( )   

4) The listed "Calendar Type" window is in the "Date" tab. ( ) 

5) The date and time format can be controlled but it isn't possible to control the way 

of the numbers display.       ( ) 
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26. Complete the following sentences:  

1) To open any icon in "My Computer" window, this will be by: 

A. …………………………………………..……….  

B. …………………………………………..……….. 

2) This icon     indicates to ………………….……….. 

3) The windows of the windows operating system are similar in 

………………….……….and ………………….……….. 

4) When connecting "Flash Memory" to the computer, the icon of this media will 

appear in ………………….……….window. 

27. Correct the underlined in the following:  

1) The capacity of the floppy disk is 6.4 Megabyte. (…………………………….)  

2) CD is the biggest storage capacity.    (…………………………….)  

3) 1 Megabyte = 2000 Kilobytes.    (…………………………….) 

4) 1 Kilobyte = 8 bits.       (…………………………….) 

28. Put (√) or (X): 

1) From “My Computer" window, we can open any program from the hard disk or 

CD.         ( ) 

2) The icon    is name CD drive.   ( ) 

3) From " My Computer" window, we can know which of the storage media has 

the biggest size.         ( ) 

4) Any icon in "My Computer" widow can be opened through the shortcut menu.  

         ( ) 
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29. Complete: 

1) The Free Space in (E) is 

…………………………….. 

2) The Total Space (Capacity) of the disk is 

…………………………….. 

3) The Used Space is 

…………………………….. 

30. Complete the following sentences from between brackets: 

(Right Click – Open – New – Files – Folders - File) 

1) To open a file or folder, double click on it or select ………………….……….From 

the shortcut menu.  

2) The folder contains ………………….………., ………………….……….. 

3) The file or folder shortcut menu appears at ……………….……….. 

4) ………………….……….Is a location which contains related data. 

5) To create a new folder, select "Folder" from ………………….……….Menu. 

31. What is the type of view? 

 

 

 

  

 

 

…………………

. 

…………………

. 

…………… 
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32. Match: 

(A) (B) 

1 Tiles A For getting additional data. 

2 Details B 
For displaying the images and video files without 

opening the files. 

3 List C Small icons and the spaces between them are small. 

4 Icons D Icons with the name of the file on right. 

5 Thumbnails E Less size than "Icons" and are displayed vertically. 

 

 

33. Put (√) or (X):  

1) It is preferred that the name of file or folder should express its contents. (    ) 

2) The folder is as a container which contains files and secondary folders.   (    ) 

3) The file has one form only.           (    ) 

4) To change the folder name, select "Name" from the shortcut menu.    (    ) 

5)  The folder has a main role in organizing the files in the computer and 

accessing them easily.            (    ) 

34. Re-arrange the steps to create a new folder named “Computer”:  

(   ) Select "Folder" 

(   ) Press Enter 

(   ) Right click on the free space of the desktop 

 (   ) Select "New" 

 (   ) Type "Computer"  

(1,……..) (2, ……..) (3, ……..) (4, ……..) (5, ……..) 
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35. Complete the following sentences from between brackets:  

1) …………………..… View is used to know the biggest sized file.  

2) We can get the different methods of the display from …………………..… Menu. 

3) …………………..… allows changing icons view in many ways. 

36. Complete the following sentences from between brackets: 

(Shortcut menu – Auto Arrange – Capacity measurement – Size - Type) 

1) …………………..… Arrangement is the best way for knowing the number of the 

text files in the window. 

2) Arrange Icons By …………………..… will make it possible to know the size of 

the image files in the window. 

3) We change view of displaying icons from "View" menu or by……………………..…. 

4) The various sizes of the files can be differentiated by……………………..…. 

5) To arrange the icons without using the manual method select from the shortcut 

menu of "Arrange Icons By" ………………………………..…. 

37. Complete the following sentences from between brackets: 

(Copy - Paste – Cut – Keyboard – Ctrl – deleted - RAM) 

1) The file can be deleted by pressing "Delete" button in ……………………………..…. 

2) To select separated files and folders in the same window, use……………button. 

3) When clicking on   the file will be ……………………………..…. 

4) When copying a file, the windows will store it in …………………..…. 

5) When clicking  icon from the window Tool Bar the selected file will 

be ……………………………..…. 

6) The icon   indicates to ………… And this icon   indicates to 

……………………………..…. 
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38. The methods for getting different bases of display are:  

1) …………………………...……………... 

2) …………………………...……………... 

39. Put (√) or (X): 

1) When selecting "Paste" from "Edit” menu, the previously stored names and 

path of the files will be pasted.             (     ) 

2) To delete the file select it and press the "Delete" button in the keyboard.  (     ) 

3) When deleting a file by using "Delete" it will not be possible to restore it. (     ) 

4) When using "Cut", the original files will not leave its original location unless 

after pasting them in another location.             (     ) 

5) To select approximated files, use "Shift" button from the keyboard with the 

mouse.                  (     ) 

40. Match  

(A) (B) 

1 Ctrl + X A Copy 

2 Ctrl + C B Paste 

3 Ctrl + V C Cut 

 

 

 

 

(1,……..) (2, ……..) (3, ……..)  
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Model One 

A. Put (√) or (×): 
1. The computer should be turned off safely.    ( ) 

2. "Copy" is used in moving the files from a location to another on the 

computer.         ( ) 

3. From the advantages of windows operating system that it has a graphical 

environment.          ( ) 

4. The icons of the desktop can't be re-arranged again.  ( ) 

5. To get the shortcut menu, double click on the desktop. ( ) 

B. Complete the following sentences from the brackets: 

(Laptop – Title – Turn off Computer – Double click – menus – Taskbar) 

1. To turn off the computer safely, select ……….……….……. From "Start" menu. 

2. ……….……….……. works depending on the battery for saving the electricity. 

3. You can open "My Computer" window by ……….…………..……on its icon on 

the desktop. 

4. There are control buttons in the window in the ……….……….……. Bar. 

5. From the main contents of the desktop……….……….…….. 

C. Match: 

(A) (B) 

1  A The window restores its size. 

2  B To minimize the window on the taskbar. 

3  C Close the window. 

4  D Maximize the window. 

(1,……..) (2, ……..) (3, ……..) (4, ……..) 
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Model Two 
A. Put (√) or (×): 

1. Hard disk is the fastest storage media.   ( ) 

2. To select a set of approximated files, use "Ctrl".  ( ) 

3. From the functions of the taskbar is the easiness of moving between the open 

programs and windows.      ( ) 

4. The importance of setting the date and time is for checking the date and time 

of the files creation.       ( ) 

5. There is no difference between CD and DVD.  ( ) 

B. Complete the following sentences from the brackets: 

(Zero – Type – Space – Rename – Arrange Icon By) 

1. From the examples of the special symbols ……………..………. 

2. To rename the file or folder, select ……………..………from the shortcut menu. 

3. To arrange the icons of the desktop, select……………..………From the shortcut 

menu. 

4. The dates are stored in the computer in the form of (One, ……………). 

5. ……………..……… arrangement is used to make the files of the same types 

approximated. 

C. Arrange the following steps for restarting the computer: 

1. Select "Turn off Computer".  ( ) 

2. Click "Restart".    ( ) 

3. Click "Start" to open the menu.  ( ) 
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Model Three 

A. Put (√) or (×): 

1. All the computers have the same number of icons on the desktop. ( ) 

2. The type of the icons display in the window can be changed from "View" menu.

              ( ) 

3. "Byte" is of the units for measuring the storage capacity and it equals (6) bits. 

              ( ) 

4. The place of the "Power" button doesn't differ from a computer to another. (       ) 

5. All the windows in the Windows Operating System has title bar.  ( ) 

B. Complete the following sentences from the brackets: 

(Regional and Language Options – Folder –X – C – Taskbar – Clipboard – Copy) 

1. …………………. is a storage container which contains files and folders. 

2. Press "Ctrl + …………………. " buttons to copy a file. 

3. To control the format on numbers, date and time select 

………………………………………………….………. Icon from the Control Panel. 

4. It is possible to check the time and current date by ………………….. 

5. When we make a copy of a file, it moves to …………………. in Windows. 

C. Arrange the following steps for changing the desktop background: 

1. Select the desired image from the "Background" menu.  ( ) 

2. Click "OK".         ( ) 

3. Open the shortcut menu by right click on the desktop. ( ) 

4. Preview the background in the preview area.   ( ) 

5. Choose properties then select "Desktop" tab from the "properties" window. 

               ( ) 
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"Questions Answers" 

1. Re-arrange the following steps which show the stages of loading the 

Operating System: 

1) Make a copy of the operating system and put it in "RAM" (   3 ) 

2) Check the computer hardware and its validity.   (   2 ) 

3) Press "Power" button.       (   1 ) 

4) The Operating System loads and the "Desktop" appear. (   4 ) 

2. Correct the underlined in the following sentences: 

1) The Traditional Computer works on the battery.  (Laptop) 

2) To turn the computer on, press the Monitor button. ( Power) 

3) To turn the computer off safely select Restart from the window that will appear.

        (Turn Off) 

4) To open start menu, Right click on start.   (Left) 

5) We can turn the computer off safely by pressing Ctrl +F4 buttons in the 

keyboard.      (Alt) 

3. Complete the following sentences from the brackets: 

(Graphical Operating Environment – battery – Power button – Start – Case) 

1) Laptop works by battery which needs to be charged from one time to another. 

2) "Turn Off Computer" is in Start Menu. 

3) From the advantages of "Windows" operating system is Graphical Operating 

Environment. 

4) The "Power" button is in Case. 

5) Power button has no fixed location in the computer, but it differs from a device 

to another. 
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4. Choose: 

1) To open the Computer, you should press the (Monitor – System Unit) button. 

2) To open the Monitor you should press (Monitor – System Unit) button. 

3) “Turn Off Computer” is in the (power button – Start) menu. 

4) To operate the computer, you should make sure of (The set is plugged – 

The Operating System is available  – both)  

5) To turn off the computer select (Restart – Turn Off) from the dialogue box. 

5. Put (√) or (×): 

1) The shape and location of the "Power" button doesn't differ from a computer to 

another.  ()   

2) The computer can be turned off safely by pressing the "Power" button. () 

3) Laptop works by the battery.     (√ ) 

4) There is no difference between the computer before and after operation. () 

5) There is only one way for turning the computer off safely. () 

6. Complete the following sentences from the brackets: 

(Taskbar – Icons- File – My Documents – OK – Recycle Bin) 

1) The objects which are on the desktop are named Icons. 

2) The deleted files go to Recycle Bin. 

3) The Date and Time appear on Taskbar. 

4) My Documents Is used for saving the important file and accessing them 

easily. 

5) The button OK is used for executing the orders. 
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7. Put (√) or (×): 

1) There is only one method for opening any icons on the desktop. (    ) 

2) "Paint" icon is of the main icons.  (     ) 

3) The icons with the same types can be arranged beside each other's by 

"Type".      (   √ ) 

4) The importance of the desktop icons is due to the fastness and easiness 

in using them.     (   √  ) 

5) The desktop icons can't be re-arranged again. (      ) 

8. Complete the following diagram : 

  

    

 

 

 
 

 

 

9. Match: 

1) Saves documents     (  2  ) My Computer 

2) Deals with hardware and software  (  1  ) My Documents 

3) Display Internet site     (  4  ) Recycle Bin 

4) Includes deleted files    (  5  ) My Network Places 

5) Controls the computers in a network  (  3  ) Internet Explorer 

 

1. Icon 

3. Taskbar 

2. Desktop Background 
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10. Complete the following sentences from the brackets: 

(My Documents – Manual – Shortcut – Auto Arrange – Double click – 

Right click) 

1) When right clicking on a free space on the desktop the Shortcut menu 

appears. 

2) We can open any of the desktop icons by Double click or Right click. 

3) To make the icons arrangement unchangeable, select Auto Arrange from 

"Arrange Icons by". 

4) My Documents is of the desktop main icons. 

5) To arrange the icons as a triangle, we use Manual method. 

11. Re-arrange the following steps to change the Screen Saver: 

(   3 ) Press on Screen Saver tab and select your Screen Saver. 

  (   2 ) Select Properties from the shortcut menu. 

 (   4 ) Select OK.  

   (   1 ) Press Right Click on the free space of the Desktop. 

12. Put (√) or (×): 

1) The number of the icons on the desktop differs from a computer to another.   (√) 

2) "My Computer" window is the first to appear after loading the Operating 

System.          () 

3) The image on the desktop can't be changed.   () 

4) From the functions of the desktop is organizing the work and reaching 

what we want easily.        (√) 

5) The deleted files can't be restored after being moved to the Recycle Bin.    () 

6) There is no difference between the window icons and the icons we create. ( ) 
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13. Give the suitable term for the following sentences from the brackets: 

(Taskbar – Desktop – My Computer – Icons – Screen Saver) 

1) Helps in performing the tasks quickly and by which we can know Date 

and Time.   (Taskbar) 

2) The first thing to appear after loading the Operating System window. 

(Desktop) 

3) One of the desktop icons by which we can deal with the computer 

hardware.   (My Computer) 

4) Protects the screen when we stop working on it temporarily.             

(Screen Saver) 

5) From the components of the desktop and it has a type (main and 

secondary).  (Icons) 

14. Match: 

(A) (B) 

1 Name A Arranges by date from the older to the most recent. 

2 Size B Arranges icons alphabetically. 

3 Type C Arranges according to the icons size in the memory. 

4 Modified D 
Make the icons of the same types beside each 

other's. 

 

 

15. Arrange the following steps which express the arrangement of the icons 

in unchangeable way: 

1. Select "Arrange Icons by" from the shortcut menu.   (   2 ) 

2. Right click on a free space on the desktop.     (   1 ) 

3. Select "Auto Arrange" which stops moving the icons manually.  (   3 ) 

 

 

(1, B)  (2, C) (3, D) (4, A) 
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16. Complete the following sentences: 

1) The icons of the desktop can be arranged Manual Or Automatic. 

2) To arrange the icons according to the date of their modification select Modified. 

3) To open "My Computer" icon press Double click. 

4) Auto Arrange arranges the icons that can't be arrange manually. 

17. Re-arrange the steps for changing the "Start  Menu into Classic Start Menu" 

(   3 ) Select "Start "tab menu from properties window 

(   5 ) Click "OK" 

(   2 ) Select "Properties" from the shortcut menu. 

(   1 ) Right Click on the free space on the Taskbar. 

(   4 ) Select "Classic Start Menu". 

18. Complete the following sentences from the brackets: 

(Display the active programs in the memory – Group similar taskbar 

buttons – Tab – Antivirus – Close) 

1) When the icon √ beside the Group similar taskbar buttons Property is 

chosen, the similar windows are grouped in one button on the taskbar. 

2) We can alternate within the open windows by pressing Alt + Tab in the 

keyboard. 

3) Display the active programs in the memory is of the function of 

Taskbar. 

4) Antivirus Is of the programs in the memory. 

5) The window can be closed from the Taskbar by choosing Close. 
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19. Put (√) or (×): 

1) The windows button disappears from the taskbar upon closing the window. (  √   ) 

2) We can open the "Calculator" program from the "Start" menu.  (   √  ) 

3) "Lock the Taskbar" property doesn't allow you to move the taskbar. (   √  ) 

4) It isn't possible to close the similar programs in one button at one time. (     ) 

5) The deleted files can be restored by the Taskbar.    (     ) 

20. Put (√) or (×): 

1) The shape of the button of the window when the window is open is different 

from its shape when it is minimized.  ( √  ) 

2) It isn't possible to minimize or maximize the window by the use of the 

keyboard.     (  ) 

3) The Operating System windows are standard windows with one base.  ( √  ) 

4) The window icon appears in the title bar on the right beside the control 

button.      (  ) 

5) The name of the window appears on the toolbar.    (  ) 

6) We can close the window by pressing Alt+F4 in the keyboard.  ( √ ) 

21. Complete the following sentences from the brackets: 

(Title – F4 – Restore Down – Maximize – Restore Down – Task) 

1) To close the window from the keyboard, press Alt + F4. 

2) The Control Button appears in the Title Bar. 

3) The program icon appears in the Task Bar. 

4) We can restore the window size which covers the screen completely by 

Restore Down. 

5) The button Maximize and Restore Down have the same location in the 

Control Button. 
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22. Complete the following sentences from between brackets: 

(Control Panel – Creating files – Battery –Double click – Date and Time – Start) 

1) The importance of setting the date and time in windows is to know the date and 

time of Creating files. 

2) You can open the "Date and Time properties" by opening the Start menu, then 

select Control Panel. 

3) The computer save the current time and date by a memory which works 

with Battery. 

4) You can open the date and time window by Double click on the clock icon on 

the taskbar.  

5) To set the hour, minute and second click Date and Time tab above the window. 

23. Put (√) or (X):  

1) The importance of the Date and Time setting is to know the date and time of 

creating files.           ( √ )  

2) (GMT + 02:00) means that the time at this place is two hours more than Cairo 

timing.           (  ) 

3) The "Date and Time" properties are opened by right click on the clock on the 

Taskbar.            (  )  

4) You can know the current date and time from the "Control Panel".  ( √ ) 

5) You can set the day date from "Time Zone".      (  ) 

6) The calculation of the date and time stops as long as the computer is shutdown. 

            (  ) 
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24. Complete the following sentences from between brackets:  

(Control Panel – Date – Country – Time – Date and Time)  

1) To control the date format, open Date Tab.  

2) To modify the time, select Date and Time Icon from the control widow.  

3) When pointing by the mouse pointer to the clock on the taskbar, Time appears. 

4)  To change all the measures and types of numbers, currency, date and time, 

change Country.  

5) The regional options can be accessed from Control Panel Window. 

25. Put (√) or (X):  

1) The forms of date, time, numbers and currencies are not influenced by changing 

the country or area.        (  ) 

2) To get "Regional Option" window, double click on the clock on the Taskbar.(  ) 

3) To change the date, time, number and currency settings, you should install a new 

version of the windows operating system.    (  )   

4) The listed "Calendar Type" window is in the "Date" tab. ( √ ) 

5) The date and time format can be controlled but it isn't possible to control the way 

of the numbers display.       (  )   
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26. Complete the following sentences:  

1) To open any icon in "My Computer" window, this will be by: 

A. Double click on the icon.  

B. Right Click on the icon and select “Open”. 

2) This icon     indicates to CD. 

3) The windows of the windows Operating System are similar in Title bar and 

Menu bar. 

4) When connecting "Flash Memory" to the computer, the icon of this media will 

appear in My Computer window. 

27. Correct the underlined in the following:  

1) The capacity of the floppy disk is 6.4 Megabyte. (1.44 MB)  

2) CD is the biggest storage capacity.    (HD “Hard disk”)  

3) 1 Megabyte = 2000 Kilobytes.    (1024) 

4) 1 Kilobyte = 8 bits.       (1024 bytes) 

28. Put (√) or (X): 

5) From “My Computer" window, we can open any program from the hard disk or 

CD.         ( √ ) 

6) The icon    is name CD drive.   (  ) 

7) From " My Computer" window, we can know which of the storage media has 

the biggest size.         ( √ ) 

8) Any icon in "My Computer" widow can be opened through the shortcut menu.  

         ( √ ) 
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29. Complete: 

1) The Free Space in (E) is 

6.61GB 

2) The Total Space (Capacity) of the disk is 

7.25GB 

3) The Used Space is 

657MB 

30. Complete the following sentences from between brackets: 

(Right Click – Open – New – Files – Folders - File) 

1) To open a file or folder, double click on it or select Open from the shortcut 

menu.  

2) The folder contains Files, Folders. 

3) The file or folder shortcut menu appears at Right Click. 

4) File Is a location which contains related data. 

5) To create a new folder, select "Folder" from New Menu. 

31. What is the type of view? 

 

 

 

 

 

 

Thumbnails 

Details 

Icons 



 

         
 

  34 

 

First Term 

 

32. Match: 

(A) (B) 

1 Tiles A For getting additional data. 

2 Details B 
For displaying the images and video files without 

opening the files. 

3 List C Small icons and the spaces between them are small. 

4 Icons D Icons with the name of the file on right. 

5 Thumbnails E Less size than "Icons" and are displayed vertically. 

 

 

33. Put (√) or (X):  

1) It is preferred that the name of file or folder should express its contents. ( √ ) 

2) The folder is as a container which contains files and secondary folders.   ( √ ) 

3) The file has one form only.           (  ) 

4) To change the folder name, select "Name" from the shortcut menu.    (  ) 

5)  The folder has a main role in organizing the files in the computer and 

accessing them easily.            ( √ ) 

34. Re-arrange the steps to create a new folder named “Computer”:  

(3 ) Select "Folder" 

(5 ) Press Enter 

(1 ) Right click on the free space of the desktop 

(2) Select "New" 

(4) Type "Computer"  

(1, D) (2, A)  (3, E)  (4, C) (5, B) 
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35. Complete the following sentences from between brackets:  

1) Details View is used to know the biggest sized file.  

2) We can get the different methods of the display from View Menu. 

3) Windows allows changing icons view in many ways. 

36. Complete the following sentences from between brackets: 

(Shortcut menu – Auto Arrange – Capacity measurement – Size - Type) 

1) Type Arrangement is the best way for knowing the number of the text files in 

the window. 

2) Arrange Icons By Size will make it possible to know the size of 

the image files in the window. 

3) We change view of displaying icons from "View" menu or by Shortcut menu. 

4) The various sizes of the files can be differentiated by Capacity measurement. 

5) To arrange the icons without using the manual method select from the shortcut 

menu of "Arrange Icons By" Auto Arrange. 

37. Complete the following sentences from between brackets: 

(Copy - Paste – Cut – Keyboard – Ctrl – deleted - RAM) 

6) The file can be deleted by pressing "Delete" button in Keyboard. 

1) To select separated files and folders in the same window, use Ctrl button. 

2) When clicking on   the file will be deleted. 

3) When copying a file, the windows will store it in RAM. 

4) When clicking  icon from the window Tool Bar the selected file will 

be Cut. 

5) The icon   indicates to Copy and this icon   indicates to Paste. 
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38. The methods for getting different bases of display are:  

1) View Menu. 

2) Right Click on a free space. 

39. Put (√) or (X): 

1) When selecting "Paste" from "Edit” menu, the previously stored names and 

path of the files will be pasted.             ( √ ) 

2) To delete the file select it and press the "Delete" button in the keyboard.  ( √ ) 

3) When deleting a file by using "Delete" it will not be possible to restore it. (  ) 

4) When using "Cut", the original files will not leave its original location unless 

after pasting them in another location.             ( √ ) 

5) To select approximated files, use "Shift" button from the keyboard with the 

mouse.                  ( √ ) 

40. Match  

(A) (B) 

1 Ctrl + X A Copy 

2 Ctrl + C B Paste 

3 Ctrl + V C Cut 

 

 

 

 

(1,C)  (2, A)  (3, B)  
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Model One 
A. Put (√) or (×): 

1. The computer should be turned off safely.    ( √ ) 

2. "Copy" is used in moving the files from a location to another on the 

computer.         (  ) 

3. From the advantages of windows operating system that it has a graphical 

environment.          ( √ ) 

4. The icons of the desktop can't be re-arranged again.  (  ) 

5. To get the shortcut menu, double click on the desktop. (  ) 

B. Complete the following sentences from the brackets: 

(Laptop – Title – Turn off Computer – Double click – menus – Taskbar) 

1. To turn off the computer safely, select Turn off Computer From "Start" menu. 

2. Laptop works depending on the battery for saving the electricity. 

3. You can open "My Computer" window by Double click on its icon on the 

desktop. 

4. There are control buttons in the window in the Title Bar. 

5. From the main contents of the desktop Taskbar. 

C. Match: 

(A) (B) 

1  A The window restores its size. 

2  B To minimize the window on the taskbar. 

3  C Close the window. 

4  D Maximize the window. 

(1,C)  (2, A)  (3, D) (4, B) 
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Model Two 
A. Put (√) or (×): 

1. Hard disk is the fastest storage media.   ( √ ) 

2. To select a set of approximated files, use "Ctrl".  (  ) 

3. From the functions of the taskbar is the easiness of moving between the open 

programs and windows.      ( √ ) 

4. The importance of setting the date and time is for checking the date and time 

of the files creation.       ( √ ) 

5. There is no difference between CD and DVD.  (  ) 

B. Complete the following sentences from the brackets: 

(Zero – Type – Space – Rename – Arrange Icon By) 

1. From the examples of the special symbols Space. 

2. To rename the file or folder, select Rename from the shortcut menu. 

3. To arrange the icons of the desktop, select Arrange Icon By From the 

shortcut menu. 

4. The dates are stored in the computer in the form of (One, Zero). 

5. Type arrangement is used to make the files of the same types approximated. 

C. Arrange the following steps for restarting the computer: 

1. Select "Turn off Computer".  (2) 

2. Click "Restart".    (3) 

3. Click "Start" to open the menu.  (1) 
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Model Three 

A. Put (√) or (×): 

1. All the computers have the same number of icons on the desktop. (  ) 

2. The type of the icons display in the window can be changed from "View" menu.

             ( √ ) 

3. "Byte" is of the units for measuring the storage capacity and it equals (6) bits. 

             (  ) 

4. The place of the "Power" button doesn't differ from a computer to another. (  ) 

5. All the windows in the Windows Operating System has title bar.  ( √ ) 

B. Complete the following sentences from the brackets: 

(Regional and Language Options – Folder –X – C – Taskbar – Clipboard – Copy) 

1. Folder is a storage container which contains files and folders. 

2. Press "Ctrl + C" buttons to copy a file. 

3. To control the format on numbers, date and time select                            

Regional and Language Options Icon from the Control Panel. 

4. It is possible to check the time and current date by Taskbar. 

5. When we make a copy of a file, it moves to Clipboard in Windows. 

C. Arrange the following steps for changing the desktop background: 

1. Select the desired image from the "Background" menu.  (3) 

2. Click "OK".         (5) 

3. Open the shortcut menu by right click on the desktop. (1) 

4. Preview the background in the preview area.   (4) 

5. Choose properties then select "Desktop" tab from the "properties" window. 

              (2) 
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